macOS Sierra
Version 10.12
A Guide to Your
System Preferences
Contents

System Preferences ...............................................................................................................................................................................4
General.............................................................................................................................................................................................5
Desktop and Screen Saver ...............................................................................................................................................................6
Dock ............................................................................................................................................................................................................7
Mission Control ..................................................................................................................................................................................8
Language & Region ........................................................................................................................................................................9
Security and Privacy - General Tab...............................................................................................................................................10
Security and Privacy - Filevault .........................................................................................................................................................11
Security and Privacy - Firewall .........................................................................................................................................................11
Security and Privacy - Privacy .........................................................................................................................................................12
Spotlight .........................................................................................................................................................................................................13
Notifications ....................................................................................................................................................................................14
Displays ............................................................................................................................................................................................15
Energy Saver .....................................................................................................................................................................................16
Keyboard ..........................................................................................................................................................................................17
Mouse .............................................................................................................................................................................................18
Trackpad ............................................................................................................................................................................................19
Printers & Scanners .........................................................................................................................................................................20
Sound ............................................................................................................................................................................................21
iCloud .............................................................................................................................................................................................22
Internet Accounts ...............................................................................................................................................................................23
App Store .........................................................................................................................................................................................24
Network ...........................................................................................................................................................................................25
Bluetooth .........................................................................................................................................................................................26
Extensions .......................................................................................................................................................................................27
Sharing ............................................................................................................................................................................................28
Users & Groups ................................................................................................................................................................................29
Parental Controls ............................................................................................................................................................................30
App Store .........................................................................................................................................................................................32
Dictation & Speech .........................................................................................................................................................................33
Date & Time ....................................................................................................................................................................................34
Startup Disk ...................................................................................................................................................................................35
Time Machine ................................................................................................................................................................................36
Accessibility .......................................................................................................................................................................................37
CDs & DVDs (Optional) .................................................................................................................................................................38
System Preferences
When System Preferences is first launched, you'll see rows of icons, each corresponding to a specific group of related options. Click on any icon to access the relevant pane. Alternatively, you can access a pane if you click-hold, Ctrl-click or right-click the System Preferences Dock icon's contextual menu.

Search in System Preferences If you're not sure exactly what you're looking for, use the built-in search in the top right corner. Click in the search field (or press Cmd+F) and start typing. As you type, the number of subjects in the results list will be filtered to match your search term, and spotlights will appear, highlighting potentially relevant panes that might offer what you require.

System Preferences in Alphabetical order You can reorder the panes by using the View menu, which provides options for organising panes by category or listing everything alphabetically.

Hiding a System Preference Pane When you select View > Customize, checkboxes appear next to each pane. Deselect any pane's checkbox and click Done and the pane will be hidden, but it will remain accessible from the View menu and when performing searches.

How Do I Remove a Third-Party preference pane? A third-party System Preferences pane can be removed either by the pane's own uninstaller (if it has one) or by Ctrl/right-clicking it and selecting Remove <Preference Pane Name>.
General
The first System Preference Pane, General, pertains to appearance, scroll bars, document behavior and the number of recent items shown in the Apple Menu.

Appearance Determines the button, menu and window theme for macOS, enabling you to switch between Blue and Graphite. This affects default buttons in dialogs, selected menu items, and also the close/minimize/full-screen buttons at the top-left of most app windows. With the Graphite theme, all of these are grey.

Use dark menu bar and Dock This turns the menu bar and Dock black, rather than white, to better fit in with some professional applications that have dark interfaces. This option also adjusts Spotlight's appearance.

Automatically hide and show the menu bar When active, this option hides the menu bar unless the cursor is at the top of the screen.

Highlight color This enables you to change the color of highlighted content such as selected text in documents. Apple provides a list of colors you can choose from, but you can define your own by selecting Other and using the standard macOS color picker.

Sidebar icon size This gives you alternate options for the size of icons in Finder's sidebar. Medium is the default, Large is good if you find it hard to click the existing icons, and Small is the best choice if you've a small display. Note that the setting you define here also affects the sidebar in Mail.

Show Scroll Bars You can adjust how scroll bars in macOS behave. By default, they are not visible, but show automatically when you move your mouse or trackpad over them. You can adjust this so that they only show when scrolling regardless of the input device or always show when content is too big for the viewport.

The Click in the scroll bar to This setting changes how macOS jumps to content when you click inside a scroll bar. With Jump to the next page selected, content jumps in screen-heights or pages, in the direction of your click; with Jump to the spot that’s clicked, it instead jumps to the point in the document relative to the location clicked on the scroll bar.

The Default web browser You can define whether Safari or another browser should launch when you, for example, click a link in an email.

Ask to keep changes when closing documents By turning on this option, you get the choice regarding whether to save the changes or revert the document to how it was when last opened.

Close windows when quitting an app When You have this unchecked, open documents should reappear as they were when you last closed an application. Check this option and applications will launch without any open documents, unless they have their own built-in settings to override macOS's default behaviour.

Recent items This option defines how many items appear in the Recent Items menu in the Apple menu. By default, up to 10 of each type (Applications, Documents, Server Volumes) are shown. Note that any setting chosen also affects recent-item Dock stacks.

Allow Handoff between this Mac and your iCloud devices This determines whether the Mac has the capability to send/receive in-progress documents to/from iCloud devices running compatible versions of macOS or iOS.

LCD font smoothing when available This option makes text appear in a slightly more pleasing manner in macOS.
Desktop and Screen Saver
The Desktop & Screen Saver pane in System Preferences is where you adjust your desktop background image and/or the screen saver that kicks in after a user-defined period of time.

Desktop Tab
You will see a thumbnail of the current background image, alongside which will be its title. On the sidebar, you can select collections of images. By default, you’ll see two under the collapsible ‘Apple’ list (Desktop Pictures and Solid Colors), and your iPhoto and/or Photos albums appear under relevant headings. The next item is a collapsible list called Folders, to which you can add custom folders by using the Add (+) button.

Changing the Desktop Background To change the desktop background, select a collection and then click any of the images within. Alternatively, you can drag an image to the well from Finder or Photos. If the image is of a suitable size and aspect ratio for your display, it will be resized automatically. If not, a menu will appear enabling you to define whether the image should fill the screen, fit to the screen as best it can, stretch, be centered, or tile.

Changing the picture automatically You can have your desktop background change at regular intervals. To do this, select a collection and then check ‘Change picture’. In the pop-up menu, define how often you’d like the background to change; options provided range from 5 seconds to daily, along with login/wake-up.

Screen Saver Tab
You will see a preview of the current screen saver. On the sidebar, you can select collections of built-in screen savers or choose Random to have one be selected at random whenever the screen saver is activated. Use the Start after menu to determine how long your Mac remains idle before the screen saver starts. A clock can be overlaid on the screen saver, by checking Show with clock.

Different Options on the screen savers Depending on the screen saver chosen, you may get options. For the various photography-based screen savers, you’ll see a Source menu, enabling you to define a source folder of photos to use. On choosing a new source, the screen saver preview will update accordingly. Checking Shuffle slide order randomises the presentation from the selection of images.

Hot Corners This button has options that are shared with Mission Control and provide the means to trigger various macOS functions when you move the cursor into a screen corner.
Dock
Many of the Dock's preferences can be adjusted by Control-clicking the thin line that divides apps and folders. However, the Dock pane in System Preferences is worth exploring, because it provides a very clear visual overview of all your Dock's settings.

Size This determines the size of the Dock icons and how much they expand when the cursor is over them.

Magnification This is best used when you've so many Dock icons that they're not easy to pick out unless zoomed. If you don't like the effect, you can disable magnification entirely.

Position on screen This determines the screen edge the Dock sits on.

Minimize windows using This menu provides two effects for when windows are minimized to the Dock: Genie and Scale. Genie appears to 'suck' the window into position. While Scale is a much simpler zoom that's less taxing on older Macs and also a lot faster.

Prefer tabs when opening documents By default this is set to 'In Full Screen Only', but you can also choose 'Always' and 'Manually' from the drop down menu. Setting to 'Always' will open new tabs in a window.

Double-click a window's into application icon This enables you to select between zoom and minimize when making that action.

Minimize windows into application icon This sends minimized windows to the relevant app icon in the Dock rather than to the Dock's right hand side.

Animate opening applications This makes apps icons on the dock bounce while launching.

Automatically hide and show the Dock This makes the Dock disappear from view when not in use, and demands you move the cursor to the relevant screen edge to show it.

Show indications for open applications This places a little black dot beneath the icons of apps that are currently running.
**Mission Control**

The Mission Control pane is the place for adjusting how Apple's window overview works. On newer Macs, F3 is a Mission Control key. In this preference pane, you can also control the settings for multiple desktops, called Spaces, that you can switch between.

- **Automatically rearrange Spaces on most recent use** This option rearranges spaces based on recent usage, rather like the Command+Tab app-switcher.
- **When switching to an application, switch to a Space with open windows for the application** This option automatically switches you to a space with an open window for an app when the app itself is switched to.
- **Group window by application** This option groups windows by application. Turn it on and Mission Control groups app windows alongside the app's icon.
- **Displays have separate Spaces** This option sets windows in separate Spaces.
- **Dashboard** This menu enables you to set Apple's widgets screen as a Space, as an overlay, or turn it off entirely. As an overlay, you'll need to click the Dashboard app icon or use a keyboard shortcut (F12) to activate it. Note that much of Dashboard's functionality now exists within Notification Center's Today view, so see if that works for you before turning Dashboard back on.
- **Keyboard and Mouse Shortcuts** This provides a centralized area to define shortcuts for activating Mission Control and the 'Application Windows' feature (which shows only the windows of the currently active app), and showing the Desktop or Dashboard. For any keyboard shortcut, you can define a function key or a modifier (a specific Shift, Control, Option or Command key), although the latter option isn't usually a good idea, because it makes the chosen modifier unavailable elsewhere. You can, however, combine a modifier and a function key: for example, to set Shift+F1 to activate Mission Control, hold Shift, open the Mission Control menu, and click F1.

It's worth noting that if your Mac keyboard includes a Mission Control icon on its F3 key, modifiers can be used in conjunction with that key in order to access Mission Control functionality: Command+F3 shows the Desktop, and Control+F3 activates the 'Application Windows' feature.

- **Hot Corners** This button has options that are shared with Mission Control and provide the means to trigger various macOS functions when you move the cursor into a screen corner.
Language & Region
This pane controls the language shown in menus and dialog boxes, and the formatting of dates, times and currencies. It will by default use the language you stated you wanted to use when you set up your Mac, along with the most appropriate formatting for your location.

Preferred languages The languages you want shown in macOS and in apps (for example, in menus and messages), and on websites (if available in a preferred language). If macOS or an app supports the primary language, that language is used. If not, the other languages are used, in the order listed. You can drag languages in the list to reorder them. Click Add (+) to add a new language to the list.

Region The geographic region whose formats are used for dates, times, numbers, and currencies. When you choose a different region, the options and the preview shown change.

First day of week The day on which a calendar week starts. This value is used in apps such as Calendar.

Calendar The type of calendar used to display dates and times.

Time Format Use a 24-hour format for the time shown in the menu bar. For example, instead of 3:00 PM, show 15:00.

Temperature changes between Fahrenheit and Centigrade.

Keyboard Preferences Open the Input Sources pane of Keyboard preferences, where you can add and remove input sources, and set options for input sources.

Advanced Change the language and formats used to display dates, times, numbers, and currencies in Finder windows and apps, such as Mail. For example, if the region for your Mac is set to United States, but the format language is set to French, then dates in Finder windows and email messages appear in French. If you just want to change how time is shown in the menu bar, select the "Time format" checkbox in the Language & Region preference pane, or select the 24-hour option in the Clock pane of Date & Time preferences. To show the date in the menu bar, also select "Show Date" in the Clock pane.

In the General pane, you can choose the language to use for showing dates, times, and numbers, and set options for numbers, currency, and measurements.

In the Dates and Times panes, you can type in the Short, Medium, Long, and Full fields, and rearrange or delete elements. You can also drag new elements, such as Quarter or Milliseconds, into the fields. If you're not using a 24-hour clock, you can replace AM and PM with whatever you type in those fields.

To undo all of your changes for a region, choose the region again from the Region pop-up menu. To undo just your changes to advanced options, click Advanced, click the pane where you want to undo your changes, then click Restore Defaults.
Security and Privacy - General Tab
You can use the settings in this pane to make your Mac more secure from malware and tampering.

Change Password Click to change the login password for the current user.

Require password... after sleep or screen saver begins Use this setting to lock your Mac when it's left in an idle state. When the Mac wakes, a user login password must be entered before the Mac can be used. You can select the amount of time after the screen saver or sleep begins before a password is required.

Show a message when the screen is locked Select to display a short message in the login window when your Mac is locked. The message will be shown to any users who attempt to log in. It can also be used to provide contact information for a lost Mac.

Disable automatic login Select to require users to authenticate with a password when they log in.

Allow apps downloaded from
- Mac App Store Select to allow only apps that have been downloaded from the Mac App Store.
- Mac App Store and identified developers Select to allow apps only from the Mac App Store, and from developers identified by Apple.
- Anywhere Select to allow any app to open, regardless of where it came from.

Advanced
- Log out after... minutes of inactivity Select to automatically log out users after the Mac is idle for the given number of minutes.
- Require an administrator password to access system-wide preferences Select to prevent users from changing locked system preferences without an administrator’s password.
Security and Privacy - Filevault
You can use FileVault encryption to protect the confidential information on your Mac.

Turn On FileVault: Click to securely encrypt all the information currently on the startup disk, and encrypt and decrypt new information as it is read and written to storage. The initial encryption may take a while, depending on the amount of data that is stored, but you can use your Mac while encryption is taking place.

When you turn on encryption, all users are required to use a password to log in. You will receive a recovery key that you can use to unlock the disk in case you forget the login password. You can add other users who are allowed to unlock and access the information on your Mac.

Turn Off FileVault: Click to decrypt the encrypted information on your Mac and stop encrypting new information.

Enable Users: Click to allow users to log in at startup and unlock the encrypted information on the Mac. Users that are not enabled need an administrator to log in before they can use the Mac.

Security and Privacy - Firewall
Use this pane to turn on the firewall in macOS to prevent unwanted connections from the Internet or other networks.

Turn On Firewall: If the firewall is turned off, click Turn On Firewall to turn on firewall protection.

Firewall Options: Click the Firewall Options button to change firewall settings. Note: this button is greyed out if the Firewall is turned off.

Block all incoming connections: In Firewall Options, select to prevent incoming connections to nonessential services and apps. Basic Internet services are a set of apps that allow your Mac to find services provided by other computers on the network. This setting prevents connections to all other sharing services.

Add (+): In Firewall Options, to add an app or service, click the Add (+) button, select the item in the list, then use the Up Arrow and Down Arrow keys to set the limits for the app.

Remove (-): In Firewall Options, to remove an app, select it in the list, then click the Remove (-) button.

Automatically allow built-in software to receive incoming connections: In Firewall Options, select to allow built-in apps and services that are signed by a valid certificate authority to be automatically added to the list of allowed apps, without your authorization. For example, iTunes is signed by Apple, so it is automatically allowed to receive incoming connections through the firewall.

Automatically allow signed software to receive incoming connections: In Firewall Options, select to allow apps and services that are signed by a valid certificate authority to be automatically added to the list of allowed apps, without your authorization. For example, iTunes is signed by Apple, so it is automatically allowed to receive incoming connections through the firewall.

Enable stealth mode: In Firewall Options, select to prevent your Mac from responding to probing requests that can be used to reveal its existence. The Mac still answers requests from authorized apps, but unauthorized requests such as ICMP (ping) get no response.
Security and Privacy - Privacy
Use this pane to manage the information your Mac makes available to others across the Internet or on a network.

Location Services When you turn on Location Services, you allow apps and websites to use your Mac’s current location to provide information, services, and features appropriate to where you are. System Services allow the location of your Mac to be used by Spotlight or Spotlight Suggestions in Safari.

Manage which apps can use Location Services Select the checkbox next to an app to allow it to use Location Services. Deselect the checkbox to turn off Location Services for that app. If you turn Location Services off for an app, you’re prompted to turn it on again the next time that app tries to use your location data.

If you allow third-party apps or websites to use your current location, you are subject to their terms and privacy policies and not the Apple Privacy Policy. You should review their terms and privacy policies to understand how they treat and use your location information.

When you use Safari and Spotlight Suggestions, the location of your Mac at the time you submit a search query to Safari or Spotlight is sent to Apple to make suggestions more relevant and to improve other Apple products and services.

Contacts, Calendars, and Reminders Shows the apps that want access to your contacts, calendars, or reminders. Deselect the app if you want to prevent it from accessing this information.

Accessibility Shows apps that run scripts and system commands to control your Mac. Deselect the app if you want to prevent it from controlling your Mac.

Diagnostics & Usage To help Apple serve customers better and improve the quality of Apple products, you can choose to automatically send diagnostic and usage information to Apple.

Other Accounts If you sign in to social media, such as Facebook, LinkedIn or Twitter, or other Internet accounts, apps that want to access the account are shown.
Spotlight

The Spotlight System Preferences pane enables you to define the kind of results that appear in Spotlight, along with the content Apple’s search system happens to index.

Search Results pane

Choose which categories appear in Spotlight search results: Select the categories you want to include, deselect those you don’t. By default, Spotlight results include Spotlight Suggestions, Bing Web Searches, conversions, documents, folders, music, and more. Allow Spotlight Suggestions in Spotlight and Look Up: Show Spotlight Suggestions in results when you search in Spotlight and look up a word. If you don’t want your Spotlight and Look Up search queries and Spotlight Suggestions usage data sent to Apple, you can turn off Spotlight Suggestions. Deselect the “Allow Spotlight Suggestions in Spotlight and Look Up” checkbox (which automatically removes Spotlight Suggestions from the list), then deselect the Bing Web Searches checkbox in the list. With the checkboxes turned off, Spotlight searches only the contents of your Mac, and Look Up searches only the dictionary on your Mac.

You can turn off Location Services for Spotlight Suggestions in Security & Privacy preferences. If you turn off Location Services on your Mac, your precise location will not be sent to Apple.

Privacy pane

Keep Spotlight from searching locations: Click the Add button, then locate the folder or disk you want to exclude. You can also drag folders or disks into the list. Remove a folder or disk from the exclusion list: Select the folder or disk, then click the Remove button.

If you add a Time Machine backup disk to the privacy list, you will continue to see messages that Spotlight is indexing your backup disk. This indexing is necessary for Time Machine to function properly and can’t be disabled. Spotlight does exclude from searches any items you store on your backup disk that are not part of a Time Machine backup.

Important: If you add certain files and folders to the privacy list you may not be notified when updates become available for some apps. If you add your entire internal disk to the privacy list, you won’t be notified about any updates.

About Spotlight Suggestions

In addition to searching your Mac, Spotlight provides Spotlight Suggestions, which shows suggestions from the Internet, iTunes, App Store, movie showtimes, locations nearby, and more in Spotlight and Look Up. When you use Spotlight or Look Up, your search queries, the Spotlight Suggestions you select, and related usage data will be sent to Apple. Search results found on your Mac will not be sent. If you have Location Services on your Mac turned on, when you make a search query to Spotlight or use Look Up the location of your Mac at that time will be sent to Apple. Searches for common words and phrases will be forwarded from Apple to Microsoft’s Bing search engine. These searches are not stored by Microsoft. To provide you with more relevant music and video suggestions, if your Mac can access music or video subscription services, then information such as the names of the subscription services and types of subscriptions may be sent to Apple. Your account name, number and password will not be sent to Apple. Location, search queries, and usage information sent to Apple will only be used by Apple to make Spotlight Suggestions more relevant and to improve other Apple products and services.
**Notifications**
Specify when you don’t want to be disturbed by notifications, and set options to control how apps show notifications and how they’re sorted in Notification Center.

**Do Not Disturb** Stop notifications during the time range you specify, when the display is in sleep, or when you’re projecting the screen. Select options to receive call notifications even when Do Not Disturb is on.

**[App] alert style** Select a style for the app’s notifications:
- **None**: Notifications don’t appear on the screen.
- **Banners**: Notifications appear on the screen and disappear after a while.
- **Alerts**: Notifications stay on the screen until you dismiss them.

**Show notifications on lock screen** When you wake your Mac from sleep, app notifications you received while it was in sleep are shown in the login window.

**Show message preview (available only for certain apps, such as Mail or Messages)** Show a preview of a message in message notifications. For example, if you receive an email, you see a preview of the email in the Mail notification.
- **when unlocked**: Message previews are shown only when you’re logged in to your user account.
- **always**: Message previews are always shown (even in the login window).

**Show in Notification Center** Choose how many of the app’s recent notifications to list in Notification Center. Notifications older than seven days aren’t shown.

**Badge app icon** Let the app show the number of notifications on its icon in the Dock.

**Play sound for notifications** Let the app play notification sounds.

**Notification Center sort order** Choose how notifications are sorted in Notification Center:
- **Recents**: Notifications are sorted by time, with the most recently received at the top. Notifications older than seven days aren’t shown.
- **Recents by App**: Notifications are grouped by app; the app with the most recent notification is listed first.
- **Manually by App**: Notifications are grouped by app; the apps are sorted based on the order in which they’re listed in Notifications preferences when this option is chosen. You can reorder apps in the list by dragging them up or down.
Displays
The options you’ll see within the Displays pane are in part reliant on your Mac hardware. You’ll see Display and Color tabs and if you have multiple displays, an added Arrangement tab will appear. There is a new feature in 10.12.4 called Night Shift. When turned on, it will gradually shift the display from blue to a subtle yellow, reducing the exposure to blue light. Blue light is believed to interrupt the circadian rhythm, disrupting sleep patterns.

Resolution On non-Retina Macs, specific resolutions will be listed (such as 1920 x 1200); on Retina Macs, you instead get pictorial representations of what your selection will achieve, labelled with the likes of 'Larger Text' and 'More Space'. Clicking an option will immediately change your display's resolution.

Brightness The slider adjusts the display's brightness setting more rapidly than using your keyboard's media keys (F1 and F2), and on notebooks you’ll have an optional checkbox for automatically adjusting brightness; this is worth keeping on at all times unless you find it doesn't work well for you.

AirPlay Display This mirrors the display to another compatible screen, such as your television via an Apple TV. This option can be more easily accessed by checking 'Show mirroring options in the menu bar when available'. This gives you a drop-down AirPlay menu alongside the likes of Spotlight and your menu-bar clock.

Color Tab
Display profile Select a display profile in the list to use for your system. After selecting a display profile, you can:
- See the details of the color profile by clicking Open Profile.
- Delete a custom color profile by clicking Delete Profile.

Calibrate Click Calibrate to calibrate your display and create a custom profile that accounts for your current light conditions, and the position and angle of the display.

Show profiles for this display only Show only the profiles that can be applied to the display on which you’re viewing Displays preferences.

Night Shift Tab
Schedule
- Off: Don’t schedule a time for Night Shift (if you choose this, you can still turn on Night Shift manually).
- Custom: Choose the times when Night Shift turns on and off.
- Sunset to Sunrise: Turn on Night Shift from sunset to sunrise.

Manual Select to turn on Night Shift; deselect to turn it off. Night Shift remains on until the next day or until you turn it off. When activated, you can turn it on or off through this Preference Pane or through your Notifications.

Color Temperature Adjust the color temperature to your liking.

Arrangement Tab (appears when one or more monitor are connected)
Display graphic representation Drag any of the displays to a different position. You can also drag the menu bar to any display.

Mirror Displays Simultaneously show the same image on your Mac and all connected displays.

AirPlay Display Use AirPlay Mirroring to wirelessly send what’s on your Mac to another display.

Show mirroring options in the menu bar when available Show devices available for AirPlay Mirroring in the menu bar.

Gather Windows Moves all open Displays preferences windows to the display where this button is. This button appears only if more than one display is connected to your Mac.
**Energy Saver**

Use Energy Saver preferences to set options that control your computer's energy use. If you have a portable Mac, these options also help you extend your battery's life.

**Battery, Power Adapter, and UPS** Click Battery, Power Adapter, or UPS, then select energy-saving options for that power source. Your Mac will use those options when it's getting power from that source.

Note: You see the Battery button only if you have a portable Mac. You see the UPS button only if your Mac is connected to an uninterruptible power source.

**Put hard disks to sleep when possible** Put the computer's hard disk to sleep whenever it's inactive.

**“Computer sleep” and “Display sleep” sliders, or “Turn display off after” slider** Drag the slider to set the amount of time your computer or display should wait before going to sleep.

**Wake for (Wi-Fi) network access** Users can access your computer’s shared resources, such as shared printers or iTunes playlists, even when your computer is in sleep mode. Note: Wi-Fi will appear if you are using the Wi-Fi as a primary connection.

**Slightly dim the display while on battery power** Reduce the brightness of the display while on battery power. Note: Appears in the Battery Tab.

**Enable Power Nap** Permits your computer to check for email, calendar, and other iCloud updates while sleeping. If turned on for Ethernet, your computer can also back up using Time Machine.

**Allow power button to put computer to sleep** Allows you to press the power button to put your computer to sleep.

**Prevent computer from sleeping automatically when the display is off** Prevents the computer from going to sleep when the display sleeps.

**Start up automatically after a power failure** Start up your Mac after a power interruption.

**Show battery status in menu bar** Show the battery icon in the menu bar. The battery icon shows when your portable Mac is connected to a power supply and the battery is charging, or shows the battery's charge level. You can also choose to show the percentage of battery power remaining.

**Schedule** Set a daily schedule for putting your Mac to sleep or turning it off and on.

**Automatic graphics switching** To extend the life of your battery, set your Mac to automatically switch between graphics modes.

Note: Depending on the kind of Mac you have, some options may Not appear in the Preference Pane. For example, you will not see a Battery tab on an iMac.
Keyboard
The Keyboard pane provides a great deal of control over keyboard input. The Keyboard tab has controls that change how your hardware works.

Key Repeat determine how rapidly a character repeats when its key is held down.

Delay Until Repeat This controls the delay that occurs before the repeating starts.

Use all F1, F2, etc. keys as standard function keys This determines whether the top row of keys on your keyboard performs actions such as adjusting brightness and switching tracks in iTunes, or literally sends function-key-presses. The latter is often helpful in design software. Check the checkbox and special features will require you to also hold the 'fn' key to activate them.

Show Keyboard, EMoji & Symbols Viewers in menu bar This enables you to access the Keyboard Viewer and Emoji & Symbols from the menu bar.

Modifier Keys Using the menus in the drop-down sheet, you can turn off modifiers (Caps Lock, Control, Option/Alt, Command), or swap them round.

Text Tab This enables you to turn on auto-correct and smart quotes/dashes, and also to set the formatting of smart quotes. Software will sometimes override any defined system default, and require you to specifically turn on such changes. The Replace/With table is for adding specific corrections, which is useful for regular typos you make that macOS does not correct or spellings it erroneously updates. It can also be used as a basic text expansion tool, for example expanding ‘omw’ to ‘On my way!’

Shortcuts Tab This houses system-wide and custom app-specific shortcuts. These are categorized in sections, selected from the pane on the left; click one and you’ll see all associated shortcuts on the right. Below the right-hand pane is a Restore Defaults button that reverts any changes for the current category alone.

Shortcuts are edited by double-clicking the zone to the right of a shortcut’s name and then holding your preferred key combination. For example, select Screen Shots in the left pane, then double-click to the right of ‘Save picture of screen as a file’ and hold Ctrl and -. This will update the shortcut for taking a screenshot from the standard Shift+Cmd+3. Should you create a custom shortcut that clashes with another, you’ll be informed (a warning triangle will be displayed, and also highlight the relevant category where the clash has occurred) and should then change one of them.

Input Sources Tab Add input sources so you can type in other languages, and set options for specific sources. When you use an input source, you can type in any language that uses the same script or alphabet.

Dictation Tab provides access to the interface for setting up dictation functionality. You choose an input source from the menu under the mic icon, select a language from the ‘Language’ menu, and choose a shortcut for activating dictation (Fn twice by default) from the ‘Shortcut’ menu. When dictation is active, a little microphone pop-up appears and you can start talking.

Set Up Bluetooth Keyboard This will allow you to add a Bluetooth Keyboard to your Mac.
Mouse
Set your preferences for a mouse connected to your Mac. The pane’s appearance can vary greatly the options presented depending on the mouse connected. Plug in a regular Apple Mouse and you will see different settings for the mouse.

Magic Mouse
Magic Mouse is a point-and-click mouse that lets you click and double-click anywhere on the Multi-Touch surface. The Multi-Touch area covers the whole surface of Magic Mouse, and the mouse itself is the button. Scroll in any direction with one finger, swipe through webpages and photos with two fingers, and click or double-click anywhere.

Point and Click:
- Scroll direction: natural: Select this option to move the contents of a window in the same direction as your fingers.
- Secondary click: Select the option, then choose “Click on the right side,” or “Click on the left side” to secondary (or Control) click items on your screen.
- Smart zoom: Select this option to double-tap with one finger to zoom in or out.
- Tracking speed: Adjust how fast the pointer moves when you drag the mouse.

More Gestures:
- Swipe between pages: Select this option and choose “Scroll left or right with one finger,” “Swipe left or right with two fingers,” or “Swipe with one or two fingers” to move between pages in a document.
- Swipe between full-screen apps: Select this option to move between apps in full screen.
- Mission Control: Select this option to double-tap with two fingers to enter Mission Control.

Mouse battery level: Shows how much charge is left on your Magic Mouse

Apple Mouse
Apple Mouse is a wired, point-and-click mouse that lets you click and double-click anywhere on the surface. The Apple Mouse’s Scroll Ball offers full 360-degree scrolling capability. When you give the Apple Mouse a squeeze, force-sensing side buttons can be configured to activate Mac macOS features such as Dashboard, Exposé or a whole host of other customizable features.

Scroll direction: natural: Select this option to move the contents of a window in the same direction as your fingers.

Set the sliders. As you adjust the sliders, try moving and clicking your mouse to see the effect of your changes.
- Tracking: Adjusts how fast the pointer moves when you drag the mouse.
- Double-Click: Adjusts how rapidly you must click for your Mac to recognize a double-click.
- Scrolling (if your mouse has a scroll ball or wheel): Adjusts how quickly the pointer moves when you scroll. The scroll ball doesn’t scroll menus or sliders in dialogs.

Set Up Bluetooth Mouse Allows you to remove a bluetooth Mouse from your Mac.
Trackpad
The Trackpad pane enables you to define functionality for your notebook’s built-in trackpad, or for a Magic Trackpad connected to a desktop machine via Bluetooth. The Trackpad pane provides three tabs: Point & Click, Scroll & Zoom and More Gestures.

Point & Click Tab
- **Look up & data detectors**: Select this option to quickly look up a word or do quick tasks with certain types of data, such as dates and addresses, then choose “Force click with one finger,” or “Tap with three fingers.”
- **Tap to click**: If you select this option, tapping the trackpad with one finger is the same as clicking.
- **Secondary click**: Select the option, then choose “Click with two fingers,” “Click in bottom right corner,” or “Click in bottom left corner” to secondary (or Control) click items on your screen.
- **Look up**: Select this option so you can use three fingers to double-tap a word to look it up in the dictionary.
- **Three finger drag**: Select this option so you can use three fingers to drag an item on your screen.
- **Tracking Speed**: Drag the slider to set the tracking speed of the pointer when you move it across the screen.
- **Silent clicking**: Select this option to turn off the clicking sound on a Force Touch trackpad.
- **Force click and haptic feedback**: Select this option so you can use three fingers to double-tap a word to look it up in the dictionary.

Scroll and Zoom Tab
- **Scroll direction: natural**: Select this option to move the contents of a window the same direction as your fingers.
- **Zoom in or out**: Select this option to pinch two fingers closed to zoom in, or pinch two fingers open to zoom out.
- **Smart zoom**: Select this option to double-tap with two fingers to zoom in or out.
- **Rotate**: Select this option to use two fingers to rotate items on your screen.

More Gestures Tab
- **Swipe between pages**: Select this option, then choose “Scroll left or right with two fingers,” “Swipe with three fingers,” or “Swipe with two or three fingers” to move between pages in a document.
- **Swipe between full-screen apps**: Select this option, then choose “Swipe left or right with three fingers,” “Swipe with three fingers,” or “Swipe with two or three fingers” to move between apps in full screen.
- **Notification Center**: Select this option to swipe left from the right edge of the trackpad to show Notification Center.
- **Mission Control**: Select this option, then choose “Swipe up with three fingers” or “Swipe up with four fingers” to enter Mission Control.
- **App Exposé**: Select this option, then choose “Swipe down with three fingers” or “Swipe down with four fingers” to use Exposé.
- **Launchpad**: Select this option to pinch your thumb and three fingers to display Launchpad.
- **Show Desktop**: Select this option to spread your thumb and three fingers to reveal your computer’s desktop.
Printers & Scanners

Use Printers & Scanners preferences to manage printers, scanners, and fax machines.

List of printers, scanners, and fax machines Click a device to see information, including its location and status.

Add (+) button To add a printer or scanner, click the Add (+) button, then choose from the list or type the device's information into the dialog that appears. Most printers and scanners are listed under Default. You can also add a fax machine, IP printer, or Windows printer.

Remove (-) button To remove a device, select it, then click the Remove (-) button.

Open Print Queue Open the print queue for the selected printer, where you can pause the printer, delete a print job, or move a job to another printer.

Options & Supplies View general information for the selected printer, check supply levels, or update options you added to the printer.

Share this printer on the network Let other users use your printer. They can be using a Mac, Windows, or a UNIX computer, and must be on the same local network. Mac users must have Mac OS X v10.4 or later.

Open Scanner To scan a document or image, select the scanner, then click this button.

Default printer If you choose Last Used Printer, macOS remembers the printer you used most recently at that network location.

Default paper size Choose the paper size you have loaded in your printer.
Sound
The Sound pane is where you define system alert sounds, and settings for audio inputs and outputs. It has three tabs: Sound Effects, Output and Input.

![Sound pane screenshot]

Sound Effects Tab
- **Select an alert sound**: This tab enables you to select an alert sound. Funk is the default.
- **Play sound effects through**: This enables you to define through which output you’d like alerts played. This defaults to your choice of sound output device, but can be overridden by selecting an alternate option.
- **Alert volume**: Using the slider, volume level can be adjusted to suit.
- **Play user interface sound effects**: Turns on/off the user interface sounds, for example dragging something to the trash.
- **Play feedback when volume is changed**: Turns on/off sound when changing the output sound.
- **Output volume**: Using the slider, volume level can be adjusted to suit.
- **Mute**: Mutes sound on computer.

Output Tab
- **Choose a sound output device**: From the list of sound output devices, select the one you want to use. All sound output devices available to your Mac are listed, including the computer’s internal speakers, devices plugged into your computer’s sound port (Audio port icon), USB speakers, and AirPlay devices.
- **Adjust sound output settings**: You can adjust balance and volume for sound output with the controls in the preference pane. If you select the “Show volume in menu bar” checkbox, a volume control appears in the menu bar so that you can turn the volume up or down from anywhere. To set a separate volume for alert sounds, click Sound Effects.

Input Tab
- **Choose a sound input device**: From the list of input devices, select the one you want to use. All sound inputs available to your Mac are listed. If your display has an internal microphone, it’s listed as “Display Audio.”
- **Adjust sound input settings**: If you’re recording sound through your computer’s sound port, you can adjust the input volume to compensate for the sound source being too loud or quiet.
  - For example, if you’re recording loud music, lower the input volume so the recorded sound isn’t too loud or distorted. Or if you are recording someone who is speaking softly, increase the input volume so your Mac can better capture the person’s voice.
  - To capture less background noise when using your computer’s built-in microphone, select “Use ambient noise reduction.”
iCloud

Use iCloud preferences to sign in or out of iCloud, turn iCloud features on or off, change iCloud account details, or manage iCloud storage.

Account Details  Make changes to your iCloud account, such as: name, email address, passwords, Two-factor authentication or two-step verification, payment method or rescue email.

Family Sharing/Manage Family  You see a Family Sharing button if you haven’t joined a family. You will see Manage Family button when:
- You received an invitation and want to join a family.
- You’re a family member and want to stop sharing your purchases, or leave the family.
- You set up Family Sharing and want to manage the family. For example, you want to add members or resend an invitation to join, or to control young family members’ spending.

Change feature settings  Turn on features you want to use, and turn off features you don’t want to use. Some features have additional settings you can change by clicking Options or Details near the feature name when the feature is turned on. If you turn on Contacts while your Contacts app is synced with Google Contacts, Google syncing is turned off. You should keep it turned off while using iCloud for your contacts.

Change iCloud Drive options  If iCloud Drive is turned on, click Options to select which apps can:
- Store documents and data in iCloud Drive
- Let other people look you up by your email address (the one you use as your Apple ID for iCloud)

Change iCloud Photos options  If Photos is turned on, click Options to turn the following features on or off:
- Store your entire Photos Library in iCloud
- Import your recent photos from devices without iCloud Photo Library through My Photo Stream
- Create albums to Share with other people and subscribe to other people’s Photo album

Change iCloud Keychain options  If Keychain is turned on, and your iCloud account isn’t enrolled in two-factor authentication, click Options to change:
- Whether your iCloud Security Code can be used to approve iCloud Keychain on new devices
- The iCloud Security Code and the phone number used to verify your identity after you use the iCloud Security Code

If “Waiting for approval” appears below Keychain, click Options to enter your iCloud Security Code instead of approving this Mac from another device. If you forgot your code, you can reset iCloud Keychain.

The Options button doesn’t appear if the Apple ID you use for iCloud is enrolled in two-factor authentication. With two-factor authentication, iCloud Keychain doesn’t need an iCloud Security Code or approval from another device

Change Find My Mac details  If “Location Services is off” appears below Find My Mac, click Details, then follow the onscreen instructions so you can locate this Mac.

Manage iCloud storage  When you sign up for iCloud, you automatically get 5 GB of free storage. Your iCloud storage is used for documents stored in iCloud Drive, iCloud Photo Library, iOS device backups, messages and attachments in iCloud Mail and more. If you run out of space, you can upgrade your storage. You can also remove stored items to make more space available.
Internet Accounts
Use Internet Accounts preferences to quickly set up your Internet accounts from Google, LinkedIn, Yahoo!, and other providers for multiple Mac apps, such as Mail, Contacts, Calendar, Notes, Reminders, and Messages.

WARNING: Deleting an account or turning off individual account features can remove data stored in your apps.

List of accounts (on the left) Shows the accounts already set up on your Mac. Select an account to see its features and settings.

List of account features or list of account types (on the right) If an account is highlighted on the left, its features and settings are listed on the right. Select the features you want to use and change settings as you like.

If no account is highlighted on the left, you can add one by clicking a provider such as iCloud on the right.

Add (+) button To add an account, click the Add (+) button, then in the list that appears on the right, click an account provider. You can also click Add Other Account to add an account of a type not listed on the right, such as a server on your network.

If you don’t have an account you want to add, create one on the provider’s website or request one from your network administrator.

Remove (-) button To remove the highlighted account and turn off all its features, click the Remove (-) button. If you remove an account while your Mac is set up for iCloud Keychain, the account is also removed from your other Mac computers set up for iCloud Keychain.
App Store
This pane determines the behaviour of apps you've installed from the Mac App Store. If you're not using an admin account, you'll need to click the lock to make any changes.

Automatically check for updates Have your Mac check for updates automatically.
Download newly available updates in the background Have your Mac download updates without asking you.
Install app updates Have your Mac install app updates automatically.
Install macOS updates Have your Mac install macOS updates automatically.
Install system data files and security updates Have your Mac install system files and security updates automatically.
Automatically download apps purchased on other Macs Have your Mac download apps that you purchased from the Mac App Store on other Mac computers. You must be signed in to the Mac App Store with the same Apple ID you used to purchase the apps.

Show Updates or Check Now
Click Show Updates to see available updates in the Mac App Store.
Click Check Now to check for updates.

Purchases and in-app Purchases Have your Mac always require a password for in-app purchases, or allow purchases for a 15-minute interval after the password was last entered, then require the password again after that.

Free Downloads Choose whether your Mac requires a password to receive free downloads.
Network

The Network pane is where you define network settings, enabling you to connect to the likes of wireless routers or corporate ethernet.

Location used to define specific set-ups for different places, such as home, work, or even your friends house. If you want to create a new location, from the drop-down menu, select Edit Locations. Click on the Add (+) button to create a new location.

Services (Listing on the left hand pane) This is a list of available connection types and settings related to the currently selected service. A green dot next to the service indicates, You are connected to a network. A yellow dot indicates the service is on but not connected to a network. A red dot indicates the service is off.

Add (+) button To add a new network service, click the Add (+) button, then choose an interface type and the service’s name.

Remove (-) button To remove a network service, click the Remove (-) button. Removal is immediate but can be undone using the Revert button.

Action Menu This enables you to duplicate or rename the selected service, or to make it inactive. You can set the service order, to prioritise certain connection types. The other options include the means to import and export configurations, and 'Manage Virtual Interfaces', for editing a list of such interfaces.

Advanced This opens a multi-tabbed sheet that enables you to drill down into the fine detail of network connections. Available tabs will depend on the selected service, but may include: Wi-Fi, TCP/IP, DNS, WINS, 802.1X, Proxies, Hardware and Bridge Status.

- Wi-Fi You can reorder known Wi-Fi networks, and it’s best to drag most-used ones to the top, to avoid your Mac wasting time first searching for the others when trying to connect. You can select and delete any you no longer need.

- TCP/IP This is the protocol used to connect your Mac to the internet. Generally, connections will be automatic. However, if you’ve been provided IP, subnet mask and router details to manually input.

- DNS DNS is how computers associate domain names with numerical IP addresses. Some people prefer to override default DNS settings with the likes of Google Public DNS (8.8.8.8 and 8.8.4.4), which can under some circumstances be faster.
**Bluetooth**

The Bluetooth pane is used for controlling any Bluetooth devices your Mac is paired with. Using the button under the Bluetooth logo, you can turn Bluetooth on your Mac on and off. Your Mac's name is displayed under the button.

**Devices** This Panel shows your devices that are in discovery mode devices or devices that are paired with the computer and their current status. Hover the cursor over an item and a cross button appears, which when clicked removes the item from the list. Note that if you remove an item and then want to use it later, you'll need to pair it again with your Mac.

**Show Bluetooth in menu bar** This menu extra provides a faster means of turning Bluetooth on and off, along with enabling you to connect/disconnect hardware and ascertain its battery level. It can also be used to send files to connected devices and browse files already on them.

**Advanced** This provides a few further options:

- Open Bluetooth Setup Assistant at startup if no keyboard is detected at startup
- Open Bluetooth Setup Assistant at startup if no mouse or trackpad is detected at startup
- Allow Bluetooth devices to wake this computer
Extensions
Use Extensions preferences to enable and disable Apple and third-party Mac extensions. Mac extensions, such as Markup, add extra functionality to apps or to the Finder. In Extensions preferences, you can also select the items that you want to see in the Share menu, and select widgets you want to see in Today view in Notification Center.

**All**  See all extensions you installed on your Mac. These are extensions created by third-party developers.

If the extension is a content extension that enables extra functionality in apps, you see an Actions checkbox below the extension. If it’s a Finder extension, you see a Finder checkbox. Select the checkbox to enable the extension.

**Actions**  See all content extensions installed on your Mac. Select a content extension to make it available in apps. For example, if Markup is selected, you can draw on pictures and sign documents in Mail, TextEdit, and other apps.

**Finder (available only if you have Finder extensions installed)**  See all Finder extensions installed on your Mac. Select a Finder extension to make it available in the Finder. If you don’t have an account you want to add, create one on the provider’s website or request one from your network administrator.

**Photos (available only if you have Photos extensions installed)**  See all Photos extensions installed on your Mac. Select a Photos extension to make it available in Photos while editing photos.

**Share Menu**  Select the items that you want in the Share menu, and in the Social widget in Today view in Notification Center.

- The Share menu is available in several apps, including Safari, Contacts, and the Finder. If an item is selected, but you don’t see it in an app’s Share menu, then you can’t use that item to share in that particular app.
- Only items that allow posting or messaging can appear in the Social widget.

**Today**  Select widgets, such as Find My Friends, to show in Today view in Notification Center. You can also show or hide widgets right in Today view.
Sharing

The Sharing pane opens up various aspects of your Mac to other computers on the network. The top of the pane shows the computer's name, which is editable, and the left-hand section lists services available for sharing.

- **DVD or CD Sharing** This enables you to share a built-in or connected optical drive across the network. This is useful if you've a new Mac lacking a drive but an older one that happily takes CDs and DVDs.

- **Screen Sharing** This enables the Mac's screen to be shared. The 'Allow access for' section of the main pane provides control over who can access the shared screen: all users, or specified users and groups, added or removed using the Add (+) and Remove (-) buttons. The 'Computer Settings' button provides access to allow anyone to request access, and to allow VNC users control with a specified password.

- **File Sharing** This activates a Mac's Public Folder, which has a Drop Box into which anyone on the network can drop files. The 'Options...' button in the System Preferences pane opens a sheet with settings for activating or deactivating connection types, and the 'Shared Folders' and 'Users' panels, respectively, optionally enable you to share additional folders and provide various access types to specific users or groups.

- **Printer Sharing** This provides the means for sharing a connected printer across the network.

- **Remote Login** This enables someone to log in to the Mac from another computer on the network, using SSH and SFTP.

- **Remote Management** This works with Apple Remote Desktop, and is designed for people having to manage a network of Macs.

- **Remote Apple Events** This allows applications on other Macs to send Apple events to it. An event is a task being performed on a Mac, such as opening a document or printing. So with this option activated, an AppleScript running on another Mac on the network could potentially open and print a document on your Mac.

- **Internet Sharing** You can share your Internet connection with other users on your local network.

- **Bluetooth Sharing** the Mac can share files with other Bluetooth enabled devices. The first two menus determine what happens when files are received (Accept and Save, Accept and Open, Ask What to Do, or Never Allow), and where accepted items are saved. The second set of menus determines what happens when other Bluetooth devices browse the Mac. You can choose from Always Allow, Ask What to Do and Never Allow, along with selecting a folder others can browse.
Users & Groups
If your Mac has multiple users, you should set up an account for each person so he or she can personalize settings and options without affecting other users.

Types of Users
Administrator An administrator can add and manage other users, install apps, and change settings. The new user you create when you first set up your Mac is an administrator. Your Mac can have multiple administrators. You can create new ones, and convert standard users to administrators.

Standard Standard users are set up by an administrator. A standard user can install apps and change settings for his or her own use. Standard users can't add other users or change other users' settings.

Managed with Parental Controls Users who are managed with parental controls can access only the apps and content specified by the administrator managing the user. The administrator can restrict the user's contacts and website access, and place time limits on computer use.

Sharing Only Sharing-only users can access shared files remotely, but can't log in to or change settings on the computer. To give the user permission to access your shared files or screen, you may need to change settings in the File Sharing, Screen Sharing, or Remote Management panes of Sharing preferences.

Group A group allows multiple users to have the same access privileges. For example, you can grant a group specific access privileges for a folder or a file, and all members of the group have access. You can also assign a group specific access privileges for each of your shared folders. You control a group's access to your shared folders by setting access permissions in the File Sharing section of Sharing preferences.

User picture Click the picture to edit it, then select a new picture.
• Use a picture included with macOS: Click Defaults, then select a picture.
• Take your picture using your Mac: Click Camera; when you're ready, click Take Photo.
• Use a picture from the Photos app: Click Photos. To see specific photos from a time, place, or album, click a disclosure triangle below photos, then select a group of photos. Select a picture, then click Next.
• Use a picture from the Photo Booth app: Click Photo Booth to see pictures you've taken using your Mac and the Photo Booth app. Select a picture, then click Next.

Instead of clicking the picture, you can drag and drop an image file from the Finder onto the picture.

Change Password Click the button to change the login password and password hint. To use the Password Assistant, click the key next to the Password field.

Contacts Card Click Open to view and edit your Contacts card. Only available for the user who is currently logged in.

Allow user to reset password using Apple ID Lets the user change their password for this Mac at login by entering their Apple ID and password. To use this option, the user must have set up iCloud on this Mac. However, this option isn't available if FileVault is turned on and set to allow the user to reset their password at startup using their iCloud account.

Allow user to administer this computer Makes the user an administrator for this Mac.

Enable parental controls Lets you manage a user with parental controls. To set restrictions, click Open Parental Controls.

Add (+) and Remove (-) Buttons To add a new user or group, click the Add (+) button, then enter the information for the new user or group. To delete a user or group, select it in the list, then click the Remove (-) button.
**Parental Controls**

As a parent, you want your kids to have a safe and happy experience on the Mac. Using Parental Controls preferences, you can manage, monitor, and control the time your kids spend on the Mac, the websites they visit, and the people they chat with. Use Parental Controls System Preferences to turn on parental controls for children and to allow parental controls settings to be managed from another Mac.

### Turn on parental controls

When you open Parental Controls preferences, if you see the message “There are no user accounts to manage,” you will need to add a managed user. A managed user is someone whose account you manage using parental controls. To make someone a managed user, you can create a new user with parental controls enabled or convert an existing standard user account to a managed user.

1. Choose Apple menu > System Preferences, then click Users & Groups.
2. Click the lock icon to unlock it, then enter an administrator name and password.
3. Select a standard user in the list of users, then select “Enable parental controls.”
4. If the user isn’t in the list, click the Add (+) button to create a new user. Click the Age pop-up menu, then choose an age group. Fill in the name, account, and password information, then click Create User.

Note: You can’t set up parental controls for administrators or sharing-only users.

If you want limited access for a user on the Mac, but don’t want to add that person as a user, set up a guest user account that you manage with parental controls.

1. Users list
   - To turn on parental controls for a user, select the user, then click Enable Parental Controls. If a user already has parental controls turned on, select the user to view or change settings.

2. Manage parental controls from another Mac (not shown)
   - Allow the parental controls settings for users on this Mac to be managed from another Mac on the local network. If you don’t see this option, Command-click the selected user so that no user is selected.

3. Lock
   - To make changes to Parental Controls preferences, click the lock icon to unlock it, then enter an administrator name and password.

4. Add
   - To add a user to manage with parental controls, click the Add (+) button.

5. Remove
   - To remove a user managed with parental controls, select the user, then click the Remove (-) button.

6. Action pop-up menu
   - Use this menu to copy and paste parental controls settings, remove parental controls, and remotely manage parental controls.

7. Logs
   - Monitor a child’s use of the Mac. Click Logs to get information on the child’s app and Internet activities.
8. **Set restrictions** Select a user, then click a button at the top:

- **Apps:** Prevent the child from using the built-in camera and joining multiplayer games in Game Center. Restrict a child's contact with other people through Mail. Specify which apps the child can access.
- **Web:** Limit access to websites, or allow unrestricted access.
- **Stores:** Disable access to the iTunes Store and the iBooks Store. Limit a child's access to music, movies, TV shows, apps, and books to only those with age-appropriate ratings.
- **Time:** Set time limits for weekdays, weekends, and bedtime.
- **Privacy:** Allow the child to make changes related to privacy.
- **Other:** Prevent the child from using Siri and Dictation, editing printer and scanner settings, and burning CDs and DVDs. Hide profanity in the dictionary and other sources. Prevent the Dock from being modified. Provide a simplified view of the Mac desktop.

---

**Manage parental controls from another Mac** After you set restrictions for a child on a Mac, you can manage parental controls from a different Mac. Both computers must be on the same network.

1. If you don’t see this option, there may be a user selected on the left side of Parental Controls preferences. Command-click the selected user so that no user is selected.
2. On the Mac you want to use to manage the child’s parental controls settings, choose Apple menu > System Preferences, then click Parental Controls.
3. Click the lock icon to unlock it, then enter an administrator name and password.
4. Select the user to be managed.
5. You can now change the child’s parental controls settings and monitor the activity logs.

---

**Reuse parental controls settings** You can copy a user’s parental controls settings and apply them to another user.

1. Select the user whose settings you want to copy.
2. Click the Action pop-up menu, then choose Copy Settings.
3. Select the user to whom you want to apply the copied settings.
4. Click the Action pop-up menu, then choose Paste Settings.

---

**Turn off parental controls**

1. Choose Apple menu > System Preferences, then click Parental Controls.
2. Click the lock icon to unlock it, then enter an administrator name and password.
3. Select the user, click the Action pop-up menu, then choose Turn off Parental Controls.
**App Store**

Set how App Store updates your Mac and apps. To open App Store preferences, choose Apple menu > System Preferences, then click App Store.

Automatically check for updates Have your Mac check for updates automatically.
Download newly available updates in the background Have your Mac download updates without asking you.
Install app updates Have your Mac install app updates automatically.
Install macOS updates Have your Mac install macOS updates automatically.
Install system data files and security updates Have your Mac install system files and security updates automatically.
Automatically download apps purchased on other Macs Have your Mac download apps that you purchased from the Mac App Store on other Mac computers. You must be signed in to the Mac App Store with the same Apple ID you used to purchase the apps.
Show Updates or Check Now Click Show Updates to see available updates in the Mac App Store. Click Check Now to check for updates.
Purchases and in-app Purchases Have your Mac always require a password for in-app purchases, or allow purchases for a 15-minute interval after the password was last entered, then require the password again after that.
Free Downloads Choose whether your Mac requires a password to receive free downloads.
Dictation & Speech
You can use Dictation preferences to turn on Dictation and choose a language and shortcut key.

Text to Speech
Dictation: On/Off  Turn dictation on and off.
Microphone  Click the pop-up menu below the microphone icon, then choose a microphone. If you choose Automatic, your Mac listens to the device you're most likely to use for dictation.

Use Enhanced Dictation  With Enhanced Dictation, you can dictate offline, without an Internet connection. You can also use dictation commands (also known as spoken commands) to perform tasks and control your Mac while dictating text. And in OS X v10.11 or later, you can use a dictation keyword phrase, which allows you to use dictation commands even when you're not dictating text.

The first time you turn on Enhanced Dictation, and when you add languages to use with it, macOS downloads additional software that allows dictation to work offline. The amount of free disk space required to download this software varies depending on the language.

If you don't want to download the software required to use Enhanced Dictation, you can deselect Enhanced Dictation and use server-based dictation. With server-based dictation, your words are quickly sent to Apple servers to be analyzed using the latest language data. The final converted text appears after you end dictation.

Language  Choose your language. Dictation is not available in all languages. If you don't see the language you want in the pop-up menu, choose Add Language or Customize to download it. You can download multiple languages. If you no longer want to use a language you downloaded, you can remove it. Click the Language pop-up menu, choose Customize, then deselect the language you don't want to use.

Shortcut  By default, you press the Fn (Function) key twice to start or stop dictation. If you like, you can choose a different shortcut from the pop-up menu. To create a shortcut that's not in the list, choose Customize, then press the keys you want to use. For example, you could press Option-Z.

About Dictation and Privacy  Click to see a message about how Dictation sends your dictated speech to Apple and uses your personal information such as your name, your contacts, and other data to understand you better and recognize what you say.

Text to Speech
System Voice  Choose a voice to speak text and alerts.
Speaking Rate  Set the speed at which text is spoken. Click the Play button to hear sample spoken text.
Announce when alerts are displayed  Have your Mac announce when alerts are shown. Click Set Alert Options to specify the voice used for alerts; the phrase (such as the app name or "Attention!") to speak before the alerts; and how long your Mac waits before it speaks the alert.
Speak selected text when the key is pressed  Select to have text in the current window spoken when you press the specified key. To customize, click Change Key, then press the key combination you want to use. (For example, press the Option and Tab keys together to change to Option+Tab.)
Date & Time

Use Date & Time System Preferences to set the date and time on your Mac. You can have the date and time set automatically using a network time server, or set your computer’s date and time manually. Be sure your time is correct so time stamps on emails, messages, and files are correct.

Date & Time

• Set the time automatically: Select “Set date and time automatically,” click the pop-up menu, then choose the server that’s closest to you, or type the address of your network time server.

  If your Mac isn’t connected to the Internet, it connects when you choose this option.

• Set the time manually: Deselect “Set date and time automatically.” Click today’s date on the calendar, drag the clock’s hands to show the correct time (or enter the time), then click Save.

  You can also use the up and down arrows next to the date or time field, or type over the current date or time.

Time Zone

• Set the time zone automatically: Select “Set time zone automatically using current location.”

• Set the time zone manually: Deselect “Set time zone automatically using current location,” click a location on the map, click the Closest City pop-up menu, then choose the city closest to your location.

Clock

• Show date and time in menu bar: Select the checkbox to see the date and time in the top-right corner of the menu bar. In “Time options” and “Date options,” set how you want the date and time to appear.

• Announce the time: Select the checkbox to hear the time announced, then choose when you want it announced. If you want, you can customize the voice.
Startup Disk
You can tell your Mac which disk to start up from when more than one startup disk is connected. A "startup disk" is a volume or partition of a drive that contains a usable operating system. You can set your Mac to automatically use a specific startup volume, or you can temporarily override this choice at startup.

Set the default startup disk You can change the startup disk your Mac automatically uses from System Preferences.
1. From the Apple menu choose System Preferences.
2. Click the Startup Disk icon in System Preferences, or choose View > Startup Disk.
3. Select your startup disk from the list of available volumes.

Target Disk Mode Target disk mode lets you share files between two Mac computers with FireWire, Thunderbolt 2, USB-C, or Thunderbolt 3 (USB-C) ports. This is useful when you need high transfer speeds or if the display on one of your computers isn't working and you need to get files from it. Essentially, it makes your Mac act as an external hard drive.
**Time Machine**

Time Machine is the built-in backup feature of your Mac. To use it, you need an external storage solution, sold separately:

- External hard drive connected to a USB, FireWire, or Thunderbolt port on your Mac
- Time Capsule or macOS Server on your network
- External hard drive connected to the USB port of an AirPort Extreme base station on your network

**Set up Time Machine** When you connect an external hard drive directly to your Mac, you might be asked if you want to use the drive to back up with Time Machine. Click “Use as Backup Disk.” If you select the option to encrypt, your backups will be accessible only to users with the password.

1. Open Time Machine preferences from the Time Machine menu (Time Machine icon in the menu bar or choose Apple menu () > System Preferences, then click Time Machine.
2. Click Select Backup Disk, Select Disk, or Add or Remove Backup Disk.
3. Select a backup disk from the list, then click Use Disk.
4. For additional backup security and convenience, you can repeat these steps to add another backup disk. For example, you might use one backup disk while at home, and another backup disk while at work.

**Select Disks** This allows you to choose external volumes for Time Machine to backup your data to. You can choose and external hard drive or a Time Capsule volume. You also have an option to encrypt your backups to keep it secure.

**Options** This will give you a choice on what to exclude from your backup. You can exclude a whole volume or just your System folder.
**Accessibility**

Accessibility comes standard in a Mac. Whether you have difficulties with vision, hearing, or physical mobility, macOS includes a variety of features to help you work in alternative ways—and make your Mac even easier to use.

---

**Use the built-in screen reader called VoiceOver**

VoiceOver is the built-in screen reader that describes aloud what appears on your screen and speaks the text in documents, webpages, and windows. Using VoiceOver, you control your Mac with the keyboard or trackpad gestures. You can also connect a refreshable braille display to use with VoiceOver.

- To turn VoiceOver on or off, press Command-F5.
- To customize VoiceOver using VoiceOver Utility, press Control-Option-F8 (when VoiceOver is on).
- To learn how to use VoiceOver, choose Apple menu > System Preferences, click Accessibility, click VoiceOver, then click Open VoiceOver Training. For help with VoiceOver, choose Help > VoiceOver Help while VoiceOver Utility is open.

**Zoom content on the screen**

If items on the screen are too small, you can zoom in to make content larger and easier to see. To set zoom options, choose Apple menu > System Preferences, click Accessibility, then click Zoom.

**Reduce motion on the screen**

If motion on the screen is problematic, you can set an option to reduce motion when using certain features, such as Spaces, Notification Center, or the Dock. To set the option to reduce motion, choose Apple menu > System Preferences, click Accessibility, then click Display.

**Use your keyboard in different ways**

If you have trouble using the keyboard, you can turn on Sticky Keys and Slow Keys, to make it easier to press keys. To set these options, choose Apple menu > System Preferences, click Accessibility, then click Keyboard.

**Move the pointer using the keyboard**

If you have trouble using a mouse, you can turn on Mouse Keys, then use the keyboard or a numeric keypad to move the mouse pointer and press the mouse button. To set this option, choose Apple menu > System Preferences, click Accessibility, then click Mouse & Trackpad.

**Use dictation commands and text to speech**

When Enhanced Dictation is on, you can use dictation commands to open apps, choose menu items, and more. macOS provides a large number of commands, and you can create your own dictation commands. With Speech options, your Mac can speak the text in dialogs and alert messages, and notify you when an app needs you to do something, such as accept a Messages invitation.

**Change how your keyboard, mouse, and trackpad work**

You can set various options to customize how your keyboard, mouse, and trackpad work. For example, you can adjust the speed at which the pointer moves across the screen when you move your finger across the trackpad.

- To set options for your keyboard, choose Apple menu > System Preferences, then click Keyboard.
- To set options for your mouse, choose Apple menu > System Preferences, then click Mouse.
- To set options for your trackpad, including gestures, choose Apple menu > System Preferences, then click Trackpad.

**Control your Mac with assistive devices**

With Switch Control, you can use one or more adaptive accessories to enter text, interact with items on the screen, and control your Mac. Switch Control scans a panel or user interface until a switch is used to select an item or perform an action. With Dwell Control, you can use a tracking device to control the mouse, so it’s easier to enter text, interact with items on the screen, and control your Mac. Dwell Control provides a panel of buttons on which you can dwell for a specified amount of time to perform a mouse action.

To quickly set common accessibility options without opening System Preferences, press Option-Command-F5 to display the Accessibility Options shortcut panel, select the options you want to use, then click Done.
**CDs & DVDs (Optional)**

If your Mac has a built-in optical drive, or if you connect an external optical drive, you can use CDs and DVDs to play music, watch movies, or access files that were backed up on a disc.

<table>
<thead>
<tr>
<th>CDs &amp; DVDs (Optional)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Insert a CD or DVD</strong></td>
</tr>
<tr>
<td>Important: Built-in optical drives and the Apple USB SuperDrive accept only standard 120-mm (about 4.72 inches) round CD and DVD discs. Do not insert smaller or irregularly shaped discs, and do not insert a disc with anything hanging from it (for example, a cleaner disc).</td>
</tr>
<tr>
<td>Insert a disc into the optical drive, with the label facing up or toward you, until you feel the drive catches and pulls it in. You must insert the disc nearly all the way in before the drive pulls it in.</td>
</tr>
<tr>
<td><strong>Choose what happens when you insert a CD or DVD</strong></td>
</tr>
<tr>
<td>You can choose what your computer does when you insert certain types of CD and DVD discs. For example, you can open photo editing software whenever you insert a picture CD, or run an AppleScript script that backs up your important documents whenever you insert a blank DVD.</td>
</tr>
<tr>
<td>1. Choose Apple menu &gt; System Preferences, then click CDs &amp; DVDs. (If you don’t have an optical drive built into or connected to your Mac, CDs &amp; DVDs preferences aren’t available.)</td>
</tr>
<tr>
<td>2. Use the pop-up menus to choose an action for the type of inserted discs. Some apps can start processing an inserted disc immediately. For example, iTunes can immediately import songs from a music CD, and DVD Player can immediately play a video. For more information, see the help that comes with the app you want to use with the CD or DVD.</td>
</tr>
</tbody>
</table>